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Disclaimer
12d Model is supplied without any express or implied warranties whatsoever.

No warranty of fitness for a particular purpose is offered.

No liabilities in respect of engineering details and quantities produced by 12d Model are accepted.

Every effort has been taken to ensure that the advice given in this manual and the program12d Model is 
correct, however, no warranty is expressed or implied by 12d Solutions Pty Ltd.

Copyright
This manual is copyrighted and all rights reserved.

This manual may not, in whole or part, be copied or reproduced without the prior consent in writing from 
12d Solutions Pty Ltd.

Copies of 12d Model software must not be released to any party, or used for bureau applications without 
the written permission of 12d Solutions Pty Ltd.

Copyright (c) 1989-2022 by 12d Solutions Pty Ltd
Sydney, New South Wales, Australia.

ACN 101 351 991

All rights reserved.
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1  A Guide to the Notes
These notes contain the information for:
(a) Installing the release version of 12d Model 

12d Model needs to be installed on each computer it is going to run on.
For notes on installing 12d Model for the first time, or on a computer that is already running 
12d Model, go to 2 Installing 12d Model 15 Release Version on page 6

(b) Setting up a Network CodeMeter
By default when 12d Model is installed it is set up for users with a Local (single user or 
stand alone) CodeMeter that only allows 12d Model to be run on the computer with the 
Local CodeMeter attached to it. With a Local CodeMeter, if 12d Model is to be run on 
another computer with that Local CodeMeter then the Local CodeMeter must be moved to 
the new computer. And 12d Model will stop running on the computer that no longer has the 
Local CodeMeter attached to it.
To allow 12d Model to run on a number of computers without having to move a CodeMeter 
to different computers, a NETWORK CodeMeter is used.

 Stubby USB Long USB

12d Local CodeMeter also referred to as a 
Single User or Standalone CodeMeter

12d Network CodeMeter

Silver USB

 with end cap 
and ring

 without end 
cap and ring

 Note: the end cap and ring are cosmetic only

For notes on setting up a Network CodeMeter, go to 9 Network CodeMeters on page 55
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12d Model
2  Installing 12d Model 15 Release Version

2.1 Requirements for Installing & Running12d Model 15
Before Installing and running 12d Model 15, you need the following:

(a) You must have Administrator privileges to install 12d Model
(a) Approximately 2 Gigabytes of disc space is required for the installation to succeed. 
(b) A 12d Model CodeMeter or Wibu Lock for your computer

If 12d Model 15 is already running on your computer, the CodeMeter (or Wibu) lock you 
already have will work with the new version of 12d Model 15 once you have a nodes file for 
12d Model 15.

If 12d Model has NOT been running on your computer then DO NOT ATTACH THE LOCK 
TO YOUR COMPUTER until after the CodeMeter/Wibu drivers have been installed as part 
of the installation procedure.

(c) An email with the 12d Model 15 authorization file nodes.12d15n attached, or a folder with 
the 12d Model 15 authorization file nodes.12d15n or nodes.4d in it.

(d) This document which has the internet links to the required executables and files
(e) Access to the internet to download the required executables and files

Please check that you have all the above items before commencing the installation.

Also note that:
(a) 12d Model 15 will not install on Windows XP or Windows Vista.
(b) 12d Model 15 will not run with the Hardlock locks which were used for 12d Model 10 and 

earlier versions.
If you have a 12d Hardlock lock, please contact your 12d Model Reseller to obtain a 
replacement CodeMeter lock.

(c) 12d Field will only run with CodeMeter locks
If you are running 12d Field and have a 12d Wibu or 12d Hardlock lock, please contact 
your 12d Model Reseller to obtain a replacement CodeMeter.

(d) A three-button mouse is essential to efficiently use 12d Model on the desktop.

2.2 12d Model 15 is only 64 bit
Microsoft has a 64 bit Windows and an older 32 bit Windows operating system but 12d Model 15 
is only being released for 64-bit Windows.

2.3 Quick or Detailed Installation Notes
For abbreviated instructions and links for Installing the Release Version of 12d Model, go to 3 
Quick Installation Notes for 12d Model 15 on page 7.

For detailed instructions and links for Installing the Release Version of 12d Model, go to 4 
Detailed Notes for Installing 12d Model on page 12.
Page 6 Requirements for Installing & Running12d Model 15
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3  Quick Installation Notes for 12d Model 15
This chapter contains abbreviated notes for Installing 12d Model 15, and the links to download 
all the files required for the installation.

For more detailed notes on installing 12d Model, see 4 Detailed Notes for Installing 12d Model 
on page 12.

Important Note: 12d Model 15 will not install on Windows XP or Vista.

3.1 Installing and Uninstalling
(a) You need to be Administrator to install 12d Model 15 and CodeMeter and/or Wibu drivers
(b) 12d Model 15 is 64-bit only - there is no 32-bit version.
(c) You can have earlier versions of 12d Model, both 64-bit and a 32-bit, on your computer at 

the same time as 12d Model 15.
(d)  A new 12d Model 15 can't be installed if there is already a 12d Model 15 installed on your 

computer.
The 12d Model 15 Installer will check for an existing matching 12d Model 15 and if one 
exists, displays the version number and asks if you want to Uninstall it.

If you say No then the 12d Model 15 Install will terminate.
Important Note
The Uninstaller deletes everything in the Program Files\12d\12dmodel\15.00 folder so do 
not modify any of those files as they will be deleted by any future installs of 12d Model 15.

Any modification that you make to these files must go into User or User_Lib.
(e) The Uninstaller will not delete any of the training material loaded into the folders 

12d\15.0\training and 12d\15.0\courses.
The 12d Model 15 Installer will overwrite any files of the same name in those folders.

(f) Do not attach the CodeMeter or Wibu locks before installing the drivers
The 12d CodeMeter or 12d Wibu locks (dongles) must NOT be attached to the computer 
before the CodeMeter/Wibu drivers are installed (see 3.4 CodeMeter Drivers on page 8).

3.2 Hardware Locks (Dongles) Supported
(a) The brand Hardlock locks can not be used for 12d Model 15.
(b) 12d Field is only available in 12d Model 15 for CodeMeters.
(c) Network CodeMeters only support 12d Model 11 and above.
(d) The older Wibu locks (non-CodeMeter) are supported for 12d Model 15 but are being 

phased out.
Page 7Installing and Uninstalling



12d Model
3.3 12d Model Installs for Windows 10
The 12d Model Install for 64 bit Window 10 - approximately 1 Gb

https://downloads.12dmodel.com/v15/12d_Model_15_C1e/12d_Model_15_C1e_64_Setup.exe

3.4 CodeMeter Drivers
If you are using a CodeMeter for the first time on this computer, then you will need to install the 
CodeMeter drivers and this can be done as part of the 12d Model installation.

If you want to install the CodeMeter drivers separately, they can be installed with:
https://downloads.12dmodel.com/v15/12d_Model_15_C1e/CodeMeterRuntime_7_30a.exe

For the notes for installing the CodeMeter Drivers separately, see 5.4 Installing the CodeMeter 
Drivers Separately on page 35.

3.5 Certifying CodeMeters
A CodeMeter needs to be Certified over the Internet every two months. So you need to have 
access to the Internet for the first time you start up 12d Model with a CodeMeter and then at lest 
every two months.

Once 12d Model is installed, there is an environment variable AUTO_CERTIFY_DONGLE_4D 
that can set so that 12d Model automatically certifies the CodeMeter when required.

See 5 Certifying CodeMeters on page 30.

Please contact your 12d Model Reseller if you have any problems Certifying CodeMeters.
Page 8 12d Model Installs for Windows 10



Chapter 3  Quick Installation Notes for 12d Model 15
3.6 For Users with 12d Model 14 Installed

3.6.1 Setting Up Your User Folder for 12d Model 15
The folder User contains the files that you have modified to replace those that 12d Model installs 
in the folder Set_ups. For example, your own names.4d or linestyl.4d.

So if you have files in your User folder in 12d Model 14, you will probably also want to use many 
of them with 12d Model 15.

In 12d Model 14, the default place for User is c:\12d\14.00\User but it could also be pointed to 
by the environment variable USER_4D.

For 12d Model 15, you need to create a new User folder and copy to it any files from the 
12d Model 14 User folder that you want to use with 12d Model 15. You may need to copy the 
whole of the 12d Model 14 User folder to the new area.

The default location for the 12d Model 14 User folder is c:\12d\14.00\User but if the 
environment variable USER_4D was used to point to a different location for the User folder in 
12d Model 14 then you will probably want to use a non-standard User folder for 12d Model 15. If 
that is the case then you will need to change USER_4D in the env.4d file for 12d Model 15 to 
point to your User folder for 12d Model 15.

3.6.2 Setting Up Your User_Lib Folder for 12d Model 15
The folder User_Lib contains your own library files and if you had files in a User_Lib folder in 
12d Model 14, you will probably also want to use many of them with 12d Model 15.

In 12d Model 14, the default place for User_Lib is c:\12d\14.00\User_Lib but it could also be 
pointed to by the environment variable USER_LIB_4D.

For 12d Model 15, you need to create a new User_Lib folder and copy to it any files from the 
12d Model 14 User_Lib folder that you want to use with 12d Model 15. You may need to copy 
the whole of the 12d Model 14 User_Lib folder to the new area.

The default location for the 12d Model 14 User_Lib folder is c:\12d\14.00\User_Lib but if the 
environment variable USER_LIB_4D was used to point to a different location for the User_Lib 
folder in 12d Model 14 then you will probably want to use a non-standard User_Lib folder for 
12d Model 15. If that is the case then you will need to change USER_LIB_4D in the env.4d file 
for 12d Model 15 to point to your User_Lib folder for 12d Model 15.

3.6.3 Setting Up Your env.4d File for 12d Model 15
The file env.4d contains environment variables that are used to customise 12d Model.

An env.4d file is installed it the Set_Ups folder when 12d Model is installed and if a user wants to 
make any modifications to any of the environment variables in env.4d, then the modified env.4d 
file is placed in the User folder.

So if you have an env.4d file in your User folder in 12d Model 14, you will probably also want to 
use it 12d Model 15.

The default location for your modified env.4d file in 12d Model 14 is in your User folder for 
12d Model 14 so for 12d Model 15, you need to copy this env.4d file to your User folder in 
12d Model 15.
Page 9For Users with 12d Model 14 Installed
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3.6.4 Are You Using a 12d Network Lock?
If you are using a 12d Network Lock (CodeMeter or Wibu) for 12d Model 15, then the file 
dongles.4d which is in the User folder contains the information to tell 12d Model that it has to 
search for a network lock, and possibly which computer the network lock is on.

So if you are using a 12d Network Lock for 12d Model 14, you will need to copy your 
12d Model 14 dongles.4d file to the 12d Model 15 User folder.

3.7 Network CodeMeters

3.7.1 Using a 12d Network CodeMeter for the First Time
If you are setting up 12d Model to use a 12d Network CodeMeter for the first time, please read 
the section 9 Network CodeMeters on page 55. 

3.7.2 Updating Licenses in a Network CodeMeter
If you are modifying the virtual 12d Model dongle within a Network CodeMeter (for example 
increasing the number of licenses), go to section 10.5 Updating Licenses in Network 
CodeMeters on page 112. 
Page 10 Network CodeMeters
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3.8 Documentation and What’s New
The links for downloading documentation on 12d Model are given in 6 Documentation on 
page 40.

The links for downloading documentation, power points and videos on what is new in 
12d Model 15 are given in 7 What’s New in 12d Model 15 on page 49.

This ends the Quick Installation notes for 12d Model 15.

The rest of the Chapters in this document are:

4 Detailed Notes for Installing 12d Model on page 12

5 Certifying CodeMeters on page 30
6 Documentation on page 40
7 What’s New in 12d Model 15 on page 49

8 Errors Installing and Authorising on page 51
9 Network CodeMeters on page 55
10 CodeMeter Control Center & WebAdmin on page 80
Page 11Documentation and What’s New
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4  Detailed Notes for Installing 12d Model
These are the complete notes are for installing the Release version of 12d Model 15 using 
CodeMeter hardware locks. If you are using the older Wibu hardlock, please contact your 
Reseller for the installation notes.

A. Disk Space required for installing 12d Model 15
Approximately 3 Gigabytes of disc space will be required for the installation to succeed. 

Before installing 12d Model, it is best to reboot the computer.

Your login must have Administrator privileges.

B. Do not attach the 12d Model locks before installing dongle drivers
The 12d CodeMeter lock must NOT be attached to the computer before the CodeMeter drivers 
are installed during the 12d Model installation.

C. Installing
The following Steps will take you through the combined installation 12d Model and the 
CodeMeter drivers, and the setting up of the nodes.4d file.

Continue to Step 1. Installing 12d Model 15 Release Version and CodeMeter Drivers on page 13.
Page 12 Documentation and What’s New



Chapter 4  Detailed Notes for Installing 12d Model
Step 1. Installing 12d Model 15 Release Version and CodeMeter Drivers
The installer for 12d Model 15 is downloaded from the internet.

(a) Installing 12d Model and CodeMeter Drivers from the Downloaded Files:
To download the installer for 12d Model, click on

https://downloads.12dmodel.com/v15/12d_Model_15_C1e/12d_Model_15_C1e_64_Setup.exe

Note: If clicking on the link does not start up your Browser then copy the text of the link into 
your Browser.

Once the installer is downloaded, click on it (or run it) and the 12d Model installation begins.

You may get a message warning you about not being able to verify who created the file:

Click on Run so that the installation can begin.

The 12d Model 15 installation starts by unpacking the information in the installation exe and then 
the installation begins.

If the Installer detects there is an existing version 12d Model 15 already installed, you will be 
asked if the Installer can uninstall the existing version. Unless this is done, the installation can 
not proceed.

Note: The uninstall deletes everything in the Program Files\12d\12dmodel\15.00 folder so you 
should never modify any of those files.
Page 13Documentation and What’s New
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Click on Yes to continue.

You then receive a Warning that the files will be deleted.

Click on Yes to continue.

All the files in the Program Files \12d\12dmodel\15.00 folder will then be deleted, and the 
12d Model xx entry removed from the Windows Registry.

The installation of the new 12d Model can now begin and the Welcome screen is displayed.

Welcome Welcome message 

                Select Next > to continue with the installation
Page 14 Documentation and What’s New
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Software License Agreement 12d Solutions license agreement

   If you agree with the License conditions, tick on I have read and accept the terms of the 
Software License Agreement.

Select Next > to continue with the installation
Page 15Documentation and What’s New
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Select Components

tick on CodeMeter Runtime to install
the CodeMeter drivers 

to be installed without being Administrator
tick on 12d Model Update Service to allow upgrades

tick on 12d Model to install 12d Model 15
 

tick on installing all the Microsoft Redistributables

Tick on 12d Model to install 12d Model.
Tick on CodeMeter Runtime to install the latest CodeMeter drivers.
Tick on 12d Model Updater Service to allow the installation of 12d Model upgrades 
without being logged in as Administrator.
Tick on Microsoft Visual C++ Redistributables if this is the first time you have installed 
12d Model 15.
Only tick on Courses and Training if you want to install the files for the Getting Started 
manuals. NOTE: These are currently only the V14 training manuals
Only tick on Trimble Precision Runtime if you want to install the Trimble libraries.

Select Next > to continue with the installation
Page 16 Documentation and What’s New



Chapter 4  Detailed Notes for Installing 12d Model
Installation Location

Continue with the default installation folder for the software:
    C:\Program Files\12d\12dmodel\15.0 

or click on Browse to browse to another folder for the installation

Select Next > to continue with the installation

User Area

Continue with the default folder for the User Area for the software:

    c:\12d\15.0

or click on Browse to browse to another folder for the User Area.

Select Next > to continue with the installation
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Ready to Install

Click on Install to begin the actual installation

The software will be copied and installed onto the computer. 

The Microsoft C++ Redistributables will be automatically installed 
Page 18 Documentation and What’s New



Chapter 4  Detailed Notes for Installing 12d Model
DO NOT CLICK on anything on the Microsoft Redistributable panels, especially Cancel. 
The panels will disappear by themselves.

Setup Complete 

End of the installation.                       Select Finish to complete the installation

This completes the installation of the 12d Model software and CodeMeter drivers.

If you have not used a CodeMeter hardware lock on the computer before, then the CodeMEter 
can now be attached to the computer. Go to Step 2. Attach the Dongle on page 19.

If you have already been using a CodeMeter hardware lock on the computer then go to Step 3. 
SPECIAL NOTE ON CERTIFYING CODEMETERS on page 21.

Step 2. Attach the Dongle

The 12d Model CodeMeter hardware lock can now be attached to the computer.
For USB dongles:

Warning: you must have System Administration rights the first time you 
attach a USB dongle to any USB port:
When a USB dongle is attached for the first time to any USB port, Windows will detect that it 
is new hardware and needs to load the dongle drivers for that USB port - this will require 
System Administration rights.

Since the dongle drivers have already been loaded onto your computer, when the USB 
dongle is attached to a new USB port, it will be recognised as new hardware

 and Windows should automatically install the correct dongle driver.
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IMPORTANT NOTE IF THE CODEMETER IS NOT RECOGNISED:

 If the CodeMeter hardware lock is not recognised you get the Found New Hardware screen

 

please go to the section on how to find the Wibu drivers

NOTE - even though your CodeMeter is working on one USB port, if you try and attach the 
CodeMeter to a new USB port, the CodeMeter drivers will need to be installed for the new 
USB port. You will need System Administration rights to install the CodeMeter drivers on the 
new USB port.

For 12d Model to run, the CodeMeter must be attached to the USB port at all times, 
otherwise 12d Model will stop and ask you to save and exit.
Page 20 Documentation and What’s New
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Step 3. SPECIAL NOTE ON CERTIFYING CODEMETERS
The 12d CodeMeters must communicate over the Internet with a Wibu Time Server every two 
months to check that there is no problem with the CodeMeter that your 12d Model license is 
using. This is called Certifying the CodeMeter.
For Certification to occur, a computer that can access the CodeMeter must also have access to 
the Internet to run the Certification.
One month before the end of the two month period, 12d Model brings up the 
Certify CodeMeter Dongle panel which gives the number of days, minutes and seconds remaining 
until Certification is required.
If you are using a new CodeMeter from your 12d Model Reseller, then it will usually come 
already Certified.

For more information on Certifying, see 5 Certifying CodeMeters on page 30.

12d Model will not function without an authorisation file called nodes.4d.
The final step is to install and test the nodes file. Go to Step 4. Installing the Nodes.4d file on 
page 22.
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Step 4. Installing the Nodes.4d file

12d Model will not create new projects or open existing projects without an authorisation file 
called nodes.4d with valid information in it.
The information inside nodes.4d controls

(a) which 12d dongles are authorised to run 12d Model
(b) what version of 12d Model will run for a dongle
(c) what modules are authorised to run for a particular 12d dongle

To authorise 12d Model to run with your 12d dongles, a file called nodes.12dxxn where xx is 
the 12d Model version number, will have been emailed to you by your local 12d Model Reseller.

For example, for 12d Model 15 the file will be called nodes.12d15n

XXXX

XX
XX

nodes.12dXXn  (11 KB)

Installing 12d Model xx on a computer sets up a Windows file association so that a 
nodes.12dxxn file is recognised and brings up the Install a 12d Model xx Nodes File panel which 
is used is to install a nodes.4d file in the correct location.

In the email, double click on the files nodes.12dxxn and the Opening Mail Attachment panel 
comes up.
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XXXX

XX
XX

nodes.12dXXn  (11 KB)

Open
click on

15

nodes.12dXXn

Click on Open and then the Install a 12d Model xx Nodes File panel appears

XX

XX.

The choices for Operation are:

    Prepend - if a nodes.4d file already exists, the information in the nodes.12dXXn file is added 
to the beginning of the existing nodes file. A backup up copy of the existing nodes.4d is 
created.

    Replace - if a nodes.4d file already exists, it is replaced by a new nodes.4d file with the 
information in the nodes.12dxxn file in the new nodes file. A backup copy of the existing 
nodes.4d is created.

    Append - if a nodes.4d file already exists, the information in the nodes.12dxxn file is added 
to the end of the existing nodes file. A backup copy of the existing nodes.4d is created.

Select Replace, Append or Prepend and then click Install.

The new/updated nodes.4d file is created in the Destination folder (default is C:\12d\xx.00) and 
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if a nodes.4d file already existed, a backup copy of it is made.

Note - if you don’t have the file nodes.12dxxn attached to an email but instead have the file in a 
folder accessible from your computer, then you can do the following:

If there is a nodes.12dxxn file, double click on that file and the Install a 12d Model Nodes File panel 
should appear and you continue as per the instructions above.

If that doesn’t work, start up 12d Model xx and click on the Nodes.4d button at the bottom of the 
Open a Recent Project panel. This will also bring up the Install a 12d Model Nodes File panel and you 
can browse for the nodes.12dxxn file in the Source panel field. You can then continue as per the 
instructions above.

CONGRATULATIONS - 12d Model has now been successfully installed.

The folders and icons that are created in the installation are given in the sections:
 4.1 Folders Created by the Installation on page 26

 4.2 Icons Created by the Installation on page 28, 

If 12d Model did not install correctly and an Authorization Error panel came up, go to the section, 
8 Errors Installing and Authorising on page 51, of these notes.

To obtain documentation for 12d Model, go to 6 Documentation on page 40.

Expanded Important Note on Nodes.12d15n and Nodes.4d 
The 12d Model 15 nodes.12d15n file will normally be emailed to you.

During the installation of 12d Model 15, an association is created for files ending in .12d15n so 
after the installation, opening the nodes.12d15n on the email will bring up the Install a 12d 
Model Nodes File program which can copy the information in the nodes.12d15n file to the 
required area (normally C:\12d\15.00) and nodes.4d file.

If you do not have the nodes.12d15n attached to an email but instead have it in a folder and 
have installed 12d Model 15, double clicking on the nodes.12d15n file will also bring up the 
Install a 12d Model Nodes File program which can copy the information in the nodes.12d15n 
file to the required area (normally C:\12d\15.00) and nodes.4d file.

Or if the 12d Model 15 icon is clicked on, the Open a Recent Project panel comes up and clicking 
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on the Nodes button will also bring up the Install a 12d Model Nodes File program which can 
copy the information in the nodes.12d15n file to the required area (normally C:\12d\15.00) and 
nodes.4d file

Please do not change the name of the created nodes.4d file. 12d Model will only search for an 
authorization file called nodes.4d.
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4.1 Folders Created by the Installation
The 12d Model installation loads the 12d Model software into the folder

      C:\Program Files\12d\12dmodel\15.00

12d Model users normally only have read access to the Program Files folders.

12d Model software area under Program Files 

The 12d Model installation also creates an area

C:\12d\15.00
which during the installation is given read/write access for the user.

If the Courses and Training component was ticked, then the installation will place the training 
data used with the Getting Started for Design and Getting Started for Surveying manual in the 
folder 12d\15.00 (or the folder you selected)
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12d Model user areas

The folder 12d\15.00 is also the default folder where the nodes.4d file will be installed, and is 
also the default area where a user creates their own subfolders User and User_Lib for their user 
configurations of 12d Model.

Warning
An Uninstall will NOT delete any of the training material loaded into 12d\15.0\training and 
12d\15.0\courses by a previous installation.

The 12d Model 15 Install will overwrite any files of the same name in these areas.
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4.2 Icons Created by the Installation
The installation loads the appropriate components and creates the 12d Model 15 icon

icon for 12d Model 64 bit exe

The 12d Model 15 - 64 icon fire up 12d Model and attaches to the folder 12d\15.00.

4.3 Copying Existing User, User_Lib and env.4d
If you have 12d Model 14 installed on your computer, then you will probably want the files in the 
folders User and User_Lib, and env.4d to be used for 12d Model 15.

(a) The folder User contains your files that are to replace those that 12d Model installs in 
Set_ups (e.g. names.4d, linestyl.4d) and if you already have some, you will probably also 
want to use them for 12d Model 15.
For 12d Model 14, the default place for User is c:\12d\14.00\User but it could also be 
pointed to by the environment variable USER_4D.
If there is an existing User folder, you need to create a new User folder for 12d Model 15 
and copy to it any files that you want for 12d Model 15.
The default place for the new User in 12d Model 15 is c:\12d\15.00\User but if USER_4D in 
your V14 env.4d was used to point to your V14 User then you will need to change 
USER_4D in your V15 env.4d to point to your V15 User folder

You may need to copy the whole of User to the new area.
(b) The folder User_Lib contains your own library files and you will probably also want to use 

them for 12d Model 15.
For 12d Model 14, the default place for User_Lib is c:\12d\14.00\User_lib but it could also 
be pointed to by the environment variable USER_LIB_4D.
If there is an existing User_Lib folder, you need to create a new User_Lib folder for 
12d Model 15 and copy to it any files that you want for 12d Model 15.
The default place for the new User_Lib in 12d Model 15 is c:\12d\15.00\User_Lib but if 
USER_LIB 4D in your V14 env.4d was used to point to your V14 User_Lib then you will 
need to change USER_LIB_4D in your V15 env.4d to point to your V15 User_Lib folder
You may need to copy the whole of User_Lib to the new area.

(c) Setting Up Your env.4d File for 12d Model 14
The file env.4d contains environment variables that are used to customise 12d Model.
An env.4d file is installed it the Set_Ups folder when 12d Model is installed and if a user 
wants to make any modifications to any of the environment variables in env.4d, then the 
modified env.4d file is placed in the User folder.

So if you have an env.4d file in your User folder in 12d Model 14, you will probably also 
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want to use it 12d Model 15.
The default location for your modified env.4d file in 12d Model 14 is in your User folder for 
12d Model 14 so for 12d Model 15, you need to copy this env.4d file to your User folder in 
12d Model 15.

(d) Are you using a 12d Network Lock ?
If you are setting up 12d Model to use a 12d Network CodeMeter for the first time, please 
read the section 7 What’s New in 12d Model 15 on page 49. 

If you are using a 12d Network Lock (CodeMeter or Wibu) for 12d Model 14, then the file 
dongles.4d which is in the User folder contains the information to tell 12d Model that it has 
to search for a network lock, and possibly which computer the network lock is on.
So if you are using a 12d Network Lock for 12d Model 14, you will need to copy your 
12d Model 14 dongles.4d file to the 12d Model 15 User folder.

4.4 End of the Notes for Installing 12d Model 15
This ends the detailed notes for installing 12d Model 15.

If you need to set up a Network CodeMeter, go to the section 9 Network CodeMeters on 
page 55.

The links for downloading documentation on 12d Model are given in 6 Documentation on 
page 40.
The links for downloading information, power points and videos on what is new in 12d Model 15 
are given in 7 What’s New in 12d Model 15 on page 49.

The rest of the chapters in this document are

6 Documentation on page 40
7 What’s New in 12d Model 15 on page 49

8 Errors Installing and Authorising on page 51
9 Network CodeMeters on page 55
10 CodeMeter Control Center & WebAdmin on page 80
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5  Certifying CodeMeters
CodeMeters use the Certified Time capability of the CodeMeter and the CodeMeter must 
communicate over the Internet with a certified Time Server every two months to check that 
there is no problem with the CodeMeter, and to update the Certified time in the CodeMeter.

This process is called Certifying the CodeMeter.

Certifying a CodeMeter can be done
(a) manually from inside 12d Model itself

Already documented. See 5.1 Certifying CodeMeters from 12d Model on page 30
(b) automatically by 12d Model 

Already documented. See 5.2 Automatically Certifying CodeMeters from 12d Model on 
page 32

(c) outside of 12d Model when the CodeMeter is on the computer you are using outside
Using CodeMeter Control Centre - already documented in 5.3 Certifying CodeMeters 
Using Control Center on page 33.

or

(d) outside 12d Model when the CodeMeter is NOT on the computer your are using
It is possible to certify CodeMeters that are on other computers but this is usually only 
needed by Administrators. See 10.3.1 Certifying CodeMeters Using WebAdmin on page 90

5.1 Certifying CodeMeters from 12d Model

testa_bed@fred.com

One month before the end of the two month period, 12d Model will bring up the Certify 
CodeMeter Dongle panel which gives the number of days, minutes and seconds remaining until 
Certification is required.

The Certify CodeMeter Dongle panel can also be brought up from within 12d Model by the option

Project =>Management =>Dongles =>Certify CodeMeter
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The Certified time for that CodeMeter is updated to the current date by clicking on the Certify 
button.

Important Note

There is an environment variable AUTO_CERTIFY_DONGLE_4D and if it is set on then when 
the warning period is active for the CodeMeter (dongle) being used by 12d Model, 12d Model 
will automatically attempt to certify the CodeMeter and if successful, no intervention by the user 
is required. See 5.2 Automatically Certifying CodeMeters from 12d Model on page 32.
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5.2 Automatically Certifying CodeMeters from 12d Model
12d Model can automatically attempt to certify the CodeMeter whenever it is within the warning 
period (within one month of the two months after the Certified Time).
If the environment variable AUTO_CERTIFY_DONGLE_4D to 1, whenever 12d Model is started 
up, then if it is in the warning period 12d Model will automatically attempt to certify the dongle. 
And if successful, no user intervention is required. 

The environment variable AUTO_CERTIFY_DONGLE_4D is set by the Edit Environment 
Variables panel. which is brought up by the Projects =>Management =>env.4d option.

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.

Note
Any computer which has the environment variable AUTO_CERTIFY_DONGLE_4D set to 1 can 
certify the Network CodeMeter that it is using to obtain a license from a 12d dongle.

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.
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5.3 Certifying CodeMeters Using Control Center
 
The Certified Time for any CodeMeter attached to your current computer can be 
displayed by using the CodeMeter Control Center which is brought up by clicking 
on the CodeMeter icon that was installed on your task bar.

The CodeMeter Control Center shows any CodeMeters that are attached to the this computer. 
.

The Certified Time in a CodeMeter that is on this computer can be displayed and updated by 
clicking on Process >Update Time Certificates
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Note

If the CodeMeter is not on the computer you are using the then certifying the codemeter must be 
done using CodeMeter WebAdmin (see 10.3.1 Certifying CodeMeters Using WebAdmin on 
page 90).
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5.4 Installing the CodeMeter Drivers Separately
FOr some reason you may want to install the CodeMeter drivers separately to the 12d Model 
installation. In that case you only need to download the CodeMeterRuntime_7_30a.exe which is 
downloaded from:

https://downloads.12dmodel.com/v15/12d_Model_15_C1e/CodeMeterRuntime_7_30a.exe

WARNING You need to have System Administrator rights to install the CodeMeter drivers

Once you have downloaded CodeMeterRuntime_7_30a.exe, click on it to begin the installation 
process. 

Note: If clicking on the link does not start up your Browser then copy the text of the link into your 
Browser.

Installing the CodeMeter Drivers:

The script to install the CodeMeter drivers begins.
CodeMeter Setup CodeMeter Runtime Kit Setup 

         Select Next to continue.
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End-User License Agreement CodeMeter Runtime Kit Setup 

        Read the License Agreement and if you are happy with it, 
        tick "I accept the terms in the License Agreement" and then select Next to continue.

Installation Scope CodeMeter Runtime Kit Setup 

        Enter your User name and Organisation.

        Click on either Install just for you or Install for all users of this machine 
               and then select Next to continue.
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Custom Setup CodeMeter Runtime Kit Setup 

         Select Next to continue.

Ready to Install CodeMeter Runtime Kit Setup 

         Select Install to continue.
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Installing CodeMeter Runtime Kit Setup 

Completed CodeMeter Runtime Kit Setup 

         Select Finish to end.

Note: A CodeMeter icon, that is used to bring up the CodeMeter Control Center, is also installed 
on your task bar. 

Important Notes
1. Do not attach a hardware lock to your computer until after the appropriate driver is installed
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2. The CodeMeter drivers need to be at least version 6.3.
If your computer already has drivers installed and they are NOT at least version 6.3, when 
12d Model 15 starts it will stop and complain that the hardware lock drives are NOT up to 
date. 
If that is the case then

(a) Uninstall the existing CodeMeter drivers
(b) Install new CodeMeter drivers. See 5.4 Installing the CodeMeter Drivers Separately.

If you were installing the CodeMeter drivers as part of setting up a Network CodeMeter, go to  
What is Done to the Computer By Step 1.

After CodeMeter drivers have been installed, the CodeMeter can be attached to the computer. 
Go to Step 2. Attach the Dongle.
Page 39Installing the CodeMeter Drivers Separately



12d Model
6  Documentation
See

6.1 12d Model Reference Manual on page 40
6.2 Getting Started for Design Manual on page 42
6.3 Getting Started for Surveying Manual on page 44

6.4 12d Model Programming Language Manual on page 46
6.6 12dxml File Format on page 47
6.7 12da File Format on page 47

7 What’s New in 12d Model 15 on page 49

6.1 12d Model Reference Manual
The 12d Model Reference manual contains the technical information required for using 
12d Model includes information such as:

(a) the tools and concept used in 12d Model
(b) descriptions of the 12d Model screen layout, views and toolbars
(c) information on each 12d Model menu
(d) technical information on the fields in each 12d Model panel
(e) information on all the set up files for 12d Model. For example, for colours and linestyles 
(f) information on the 12d XML and 12da file formats
(g) information on the 12dfield and fld file formats

Although the 12d Model Reference manual contains some information on each of the field in 
panels, it is the technical information about what is valid values etc and is not intended to be a full 
description on how all the options work together. That is, it is NOT a training manual.

The 12d Model Reference manual also acts as a context sensitive Help system when 
12d Model is running.
That is, when 12d Model is running:

(a) for most menus in 12d Model, when the menu is on the screen and has the Windows focus, 
pressing F1 will open the 12d Model Reference manual at that menu

(b) for most panels in 12d Model, when the panel is on the screen and has the Windows focus, 
pressing F1 will open the 12d Model Reference manual at that panel. Or if the panel has a 
Help button, clicking on the Help button opens the 12d Model Reference manual at that 
panel.

The full 12d Model Reference manual is can be accessed from within 12d Model by clicking on 
the option Help =>12d Model.
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The 12d Model Reference is a pdf file and when 12d Model is installed, it is copied into the 
Help folder.

12d Model Reference manual

To download a zipped copy of the12d Model Reference manual,12d.pdf, click on the following 
link and then unzip the downloaded file

https://downloads.12dmodel.com/v15/12d_Model_15_C1e/12d_ref_V15_C1e.zip

Note: If clicking on the link does not start up your Browser then copy the text of the link into your 
Browser.

Continue to 6.2 Getting Started for Design Manual or return to 6 Documentation.
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6.2 Getting Started for Design Manual
WARNING

At the moment this is only the Getting Started for Design manual for 12d Model 14
The Getting Started manuals are currently being rewritten using a different dataset.

12d Model is supplied with a comprehensive on-line 12d Model Reference manual which 
describes the function of each menu option in detail. However, it is a Reference manual and 
makes no attempt to describe how to use 12d Model for production surveying and civil 
engineering work.
The 12d Model Getting Started for Design manual is designed to show you how to work with 
the context sensitive help system, and then as the first section of Training, help you start to learn 
how to use 12d Model to achieve typical civil engineering tasks. 

Wherever possible, The 12d Model Getting Started for Design manual uses examples to 
clarify usage. It compliments rather than replaces the 12d Model Reference manual. In general, 
information in the 12d Model Reference manual will not be duplicated in the 12d Model Getting 
Started for Design manual.

The 12d Model Getting Started for Design manual can be accessed from within 12d Model by 
clicking on the option Help =>Getting Started for Design

The 12d Model Getting Started for Design manual is a pdf file and when 12d Model is 
installed, it is copied into the Help folder.

12d Model Getting Started for Design

To download a pdf copy of the 12d Model Getting Started for Design manual, click on the 
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following link
https://downloads.12dmodel.com/v15/12d_Model_15_C1e/12dm_getting_started_for_design_V14.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into your 
Browser.

Continue to 6.3 Getting Started for Surveying Manual or return to 6 Documentation.
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6.3 Getting Started for Surveying Manual
WARNING

At the moment this is only the Getting Started for Surveying manual for 12d Model 14.
The Getting Started manuals are currently being rewritten using a different dataset.

12d Model is supplied with a comprehensive on-line 12d Model Reference manual which 
describes the function of each menu option in detail. However, it is a Reference manual and 
makes no attempt to describe how to use 12d Model for production surveying and civil 
engineering work.
The 12d Model Getting Started for Surveying manual is designed to show you how to work 
with the context sensitive help system, and then as the first section of Training, help you start to 
learn how to use 12d Model to achieve typical surveying tasks. 

Wherever possible, The 12d Model Getting Started for Surveying manual uses examples to 
clarify usage. It compliments rather than replaces the 12d Model Reference manual. In general, 
information in the 12d Model Reference manual will not be duplicated in the 12d Model Getting 
Started for Surveying manual.

The 12d Model Getting Started for Surveying manual can be accessed from within 12d Model 
by clicking on the option Help =>Getting Started for Surveying

The 12d Model Getting Started for Surveying manual is a pdf file and when 12d Model is 
installed, it is copied into the Help folder.

12d Model Getting Started for Surveying
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To download a pdf copy of the 12d Model Getting Started for Surveying manual, click on the 
following link

https://downloads.12dmodel.com/v15/12d_Model_15_C1e/12dm_getting_started_for_surveying_V14.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into your 
Browser.

Continue to 6.4 12d Model Programming Language Manual or return to 6 Documentation.
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6.4 12d Model Programming Language Manual
The 12d Model Programming Language (12dPL), is a powerful programming language 
designed to run from within 12d Model. It is also known as 4DML from when the product was 
called 4d Model.

Its main purpose is to allow users to enhance the existing 12d Model package by writing their 
own programs. These programs are often called macros.

The 12d Model Programming Language manual is a reference manual and does not try to 
teach programming techniques. Instead this manual sets out the syntax, restrictions and 
supplied functions available in 12dPL.

The 12d Model Programming Language manual can be accessed from within 12d Model by 
clicking on the option Help =>12d Macro Manual 

The 12d Model Programming Language manual is a pdf file and when 12d Model is installed, 
it is copied into the Help folder.

12d Model Programming Language manual

To download a pdf copy of the 12d Model Programming Language manual,12d_prog.pdf, click 
on the following link
https://downloads.12dmodel.com/v15/12d_Model_15_C1e/12d_progm_V15_C1e.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into 
your Browser.

Continue to 6.5 12d Field File Format or return to 6 Documentation.
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6.5 12d Field File Format
The 12d Field File Format manual contains the documentation of the 12d Model raw survey file 
format .12dfield, and the older raw survey file format, .fld.

The 12d Field File Format is part of the 12d Model Reference manual (see 6.1 12d Model 
Reference Manual) but the chapter as also been separated out so the entire 12d Model 
Reference manual is not needed.

To download a pdf copy of the 12d Field File Format manual, click on the following link

https://downloads.12dmodel.com/v15/12d_Model_15_C1e/12d_Field_File_Format_V15_C1e.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into 
your Browser.

Continue to 6.6 12dxml File Format or return to 6 Documentation.

6.6 12dxml File Format
The 12dxml file format is a text file definition from 12d Solutions which is used for reading and 
writing out string data from 12d Model. 12dxml files normally end in .12dxml.

The 12dxml file is a Unicode file.

The documentation for 12dxml is part of the 12d Model Reference manual (see 6.1 12d Model 
Reference Manual) but the chapter as also been separated out so the entire 12d Model 
Reference manual is not needed.

To download a pdf copy of the 12d Model 12dxml manual, click on the following link
https://downloads.12dmodel.com/v15/12d_Model_15_C1e/12d_xml_File_Format_V15_C1e.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into 
your Browser.

Continue to 6.7 12da File Format or return to 6 Documentation.

6.7 12da File Format
The 12da (12d Archive) file format is a text file definition from 12d Solutions which is used for 
reading and writing out string data from 12d Model. 12da files normally end in .12da.

The 12da file is a Unicode file.

The documentation for 12da is part of the 12d Model Reference manual (see 6.1 12d Model 
Reference Manual) but the chapter as also been separated out so the entire 12d Model 
Reference manual is not needed.

To download a pdf copy of the 12da File Format manual, click on the following link
https://downloads.12dmodel.com/v15/12d_Model_15_C1e/12d_a_File_Format_V15_C1e.pdf
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Note: If clicking on the link does not start up your Browser then copy the text of the link into 
your Browser.

Further Notes:

1.  12da was originally an Ascii file and stood for 12d Ascii but now that the 12da file is a 
Unicode file, 12da stands for 12d Archive.

2. 12da has now been superseded by 12d xml (see 6.6 12dxml File Format)

Continue to 7 What’s New in 12d Model 15 or return to 6 Documentation.
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7  What’s New in 12d Model 15
This chapter contains links to information on many of the new things in 12d Model 15.

See

7.1 What's New pdf on page 49
7.2 What's New Summary of Additions on page 49

7.3 What's New Summary of Additions and Fixed Bugs on page 49
7.4 What's New Summary of Additions and Fixed Bugs Sorted by Sub-Version on page 50

7.5 What's New Summary of Additions and Fixed Bugs Sorted by Sub-Version and Reverse 
Date on page 50

7.1 What's New pdf
The What’s New in 12d Model 15 pdf gives detailed information on many of the new options 
and features in 12d Model 15.

https://downloads.12dmodel.com/V15/12d_Model_15_C1e/Whats_New_in_12d_Model_15_C1e.pdf
Note: If clicking on the link does not start up your Browser then copy the text of the link into 
your Browser.

7.2 What's New Summary of Additions
A one line summary of all the additions in 12d Model 15, sorted by Component:

https://downloads.12dmodel.com/V15/12d_Model_15_C1e/WNS_V15_C1e_added.htm

Note: If clicking on the link does not start up your Browser then copy the text of the link into 
your Browser.

7.3 What's New Summary of Additions and Fixed Bugs
A one line summary of all the additions and bugs fixed in 12d Model 15, sorted by Component:

https://downloads.12dmodel.com/V15/12d_Model_15_C1e/WNS_V15_C1e_added_fixed_bugs.htm
Note: If clicking on the link does not start up your Browser then copy the text of the link into your 
Browser.
Page 49What's New pdf



12d Model
7.4 What's New Summary of Additions and Fixed Bugs 
Sorted by Sub-Version

A one line summary of all the additions and bugs fixed in 12d Model 15, broken into sub-
versions (i.e. C1a, C1b, C1d etc) and subsorted by Components: 

https://downloads.12dmodel.com/V15/12d_Model_15_C1e/WNS_V15_C1e_added_fixed_bugs_split.htm

Note: If clicking on the link does not start up your Browser then copy the text of the link into your 
Browser.

7.5 What's New Summary of Additions and Fixed Bugs Sorted 
by Sub-Version and Reverse Date

A one line summary of all the additions and bugs fixed in 12d Model 15 broken into sub-versions 
(i.e. C1a, C2b, C2c etc) and subsorted in reverse date order of the additions and bug fixes

https://downloads.12dmodel.com/V15/12d_Model_15_C1e/WNS_V15_C1e_new_fixed_bug_split_rev.htm
Note: If clicking on the link does not start up your Browser then copy the text of the link into your 
Browser.

Return to 7 What’s New in 12d Model 15.
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8  Errors Installing and Authorising
See

8.1 12d Model XX Not Authorising on page 51
8.2 Licence Expiry Warning on page 52

8.3 Dongle Missing on page 53

8.1 12d Model XX Not Authorising
If there is an error with the installation, then the Error Authorizing Release Version panel appears 
with the error messages in the panel message area.

For example, for 12d Model 11

Installation messages
and error messages area

no 12d dongle detected

A valid Company means that a nodes.4d file has
been read and there is a V11 entry in it

nodes.4d file found and being used

In the above panel, the UNKNOWN in the Dongle number column shows that no 12d dongle 
has been detected.
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If there is no error message on the panel or it is still not obvious what the problem is, please 
contact your 12d Model Reseller.

8.2 Licence Expiry Warning
The nodes.4d file that controls 12d Model, only validates 12d Model to run for a certain period 
of time.

If when running 12d Model, the Licence Expiry Warning panel appears:

it simply means that the nodes.4d file needs to be updated.

Please contact your 12d Model Reseller to obtain a new nodes file before the given date. If this 
is not done then 12d Model will no longer run until you do obtain and install a new nodes file.
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8.3 Dongle Missing
If when running 12d Model, the Dongle Missing panel appears:

it simply means that the 12d dongle can no longer be seen by 12d Model.

Please check that your 12d dongle is still attached to your computer, or if you are using a 
network dongle, that your network is still active.

Then click on Retry, and if that doesn’t work, click on Dongle retry. 

Even if you still can not see the dongle, 12d Model will allow you to save your current work so 
that nothing is lost by clicking on the Save and exit 12d button.
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9  Network CodeMeters
A 12d Local CodeMeter (also known as a Standalone or single-user CodeMeter) is a 
CodeMeter that is attached to a computer that only allows 12d Model to be run on that 
computer. 

If the 12d Local CodeMeter is to be used on another computer then the 12d Local CodeMeter 
must be moved to the other computer. This means that 12d Model will no longer run on the 
computer without the 12d Local CodeMeter.

This is the default installation for 12d Model. 

A 12d Network CodeMeter is a CodeMeter that controls a number of 12d Model licenses and 
the 12d Network CodeMeter can potentially be accessed by any other computer on the 
network, and allows copies of 12d Model to be run on those computers without needing a 12d 
Local CodeMeter.

The 12d Model licenses controlled by the 12d Network CodeMeter can be accessed and used 
in any country and any time zone, subject to any Australian and local Laws that may prevent it.
 The only restriction is that each instance of 12d Model on a computer requires its own 
12d Model license from the 12d Network CodeMeter.

12d Network CodeMeters are metallic and a silver colour, and are labelled with a number 
starting with ec.

 Stubby USB Long USB

12d Local CodeMeter also referred to as a 
Single User or Standalone CodeMeter

12d Network CodeMeter

Silver USB

 with end cap 
and ring

 without end 
cap and ring

 Note: the end cap and ring are cosmetic only

Note: When using a 12d Network CodeMeter, each running copy of 12d Model using a 12d 
Network CodeMeter on a computer requires a license from the 12d Network CodeMeter. 

If your computer is not using a 12d Local CodeMeter and is only using a 12d Network 
CodeMeter to obtain 12d Model licenses then 12d Model and the CodeMeter Drivers still need 
to be installed on the computer that is wanting to run 12d Model.
BUT when 12d Model is installed it is set up for users with a Local (single user or stand alone) 
CodeMeter and installs a dongles.4d file that assumes that 12d Model is only using a 12d 
Local CodeMeter and has no access to a 12d Network CodeMeter.

So to access a 12d Network CodeMeter, the dongles.4d file needs to be modified and the 
nodes.4d file you use will need to contain an authorization for the 12d Local CodeMeter.

Note: a computer can be set up to look for both a 12d Local CodeMeter and a 12d Network 
CodeMeter. 

To install the Network CodeMeter and configure computers to use the Network CodeMeter, you 
will need 
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1. First Install the CodeMeter drivers 
IMPORTANT WARNING
Do not attach any CodeMeters, Network or Standalone, to your computer until after you have 
installed the CodeMeter Drivers.

The latest CodeMeter Drivers installation program 12d_dongles_installation_date.exe is 
downloaded from:

https://downloads.12dmodel.com/v15/12d_Model_15_C1e/CodeMeterRuntime_7_30a.exe

For the notes for installing the CodeMeter Drivers separately, see 5.4 Installing the CodeMeter 
Drivers Separately on page 35.

2. a nodes.4d file to authorize the 12d Model xx licenses controlled by the 12d Network 
CodeMeter where xx is the 12d Model versions required.
This is usually supplied in an email a the attached file nodes.12dxxn (for example, for 
12d Model 15, it will be nodes.12d15n)

Or you may already have it in a folder with the 12d Model authorization file nodes.12dxxn or 
nodes.4d in it.

Full instructions setting up Network CodeMeters, and making the required modifications to the 
dongles.4d file and the nodes.4d file, are given in the rest of this chapter.

Continue to 9.1 Definitions and Guide to the Network Notes on page 57.
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9.1 Definitions and Guide to the Network Notes
A 12d CodeMeter Server is a computer with a 12d Network CodeMeter attached to it. Note that 
this can be any computer, it does not have to be a Server Computer.

CodeMeter Client Computers Networked to One or More CodeMeter Server Computers

CodeMeter Client
CodeMeter Client

CodeMeter Client

CodeMeter Client

CodeMeter Client

CodeMeter Client

CodeMeter Client

CodeMeter Client

CodeMeter Client

CodeMeter Client

CodeMeter Server
computer with a 
Network CodeMeter

CodeMeter Server
computer with a 
Network CodeMeter

A 12d CodeMeter Client is a computer that gets its 12d Model licenses from a 12d CodeMeter 
Server. The CodeMeter Client computer does not have a 12d Network CodeMeter attached to it.

Both CodeMeter Servers and CodeMeter Clients must have the CodeMeter Drivers and 
CodeMeter Runtime Server service installed and running and this is described in 9.2 Installing 
CodeMeter Drivers on page 59.
CodeMeter Servers must also have the CodeMeter Network Server running and this is 
described in Step 6. Starting the 12d Network Server on page 67.

To run 12d Model on a CodeMeter Client, an appropriate dongles.4d and valid nodes.4d file 
must be obtained and set up. This is describing in 9.4 dongles.4d and nodes.4d on page 69. 

These notes are for

(a) Installing and setting up a new 12d Network CodeMeter to act as a 12d License server
(b) Setting up other computers (Clients) so they can access the Network CodeMeter and 

12d Model licenses in the 12d Network CodeMeter.
(c) Setting up/Updating dongles.4d to instruct the other computers (Clients) which Network 

CodeMeters to use. This can be down to the level of using a particular virtual 12d dongle 
inside a particular 12d Network CodeMeter.

(d) Setting up/Updating the nodes.4d file with the authorization to match the 12d dongle being 
accessed inside a 12d Network CodeMeter.

(e) Updating the 12d Model licenses in a 12d Network CodeMeter

and
(f) Monitoring 12d Network CodeMeters.

WARNING
If the computers accessing a 12d Network CodeMeter are in a different subnet (behind a 
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router) to the 12d Network CodeMeter then 12d Model needs to be given the IP address or the 
computer names of the servers with the 12d Network CodeMeter. This will be explained later in 
the notes. This will also apply to computers connected by Wireless or DHCP.

If you already have a 12d Network CodeMeter and are simply updating a 12d dongle inside the 
Network CodeMeter, go to the section 10.5 Updating Licenses in Network CodeMeters on 
page 112.

if your are installing a 12d Network CodeMeter on the computer for the first time, please 
continue to the next section 9.1 Definitions and Guide to the Network Notes on page 57.

Important Note for Going From 12d Local CodeMeters to 12d CodeMeter Servers
The CodeMeter drivers are exactly the same ones that are used for a 12d Local (standalone or 
single-user) CodeMeter. So if a computer is already been used for a 12d Local CodeMeter with 
12d Model, then the CodeMeter drivers have already been installed and will not need to be 
installed again.
This means that if a 12d Network CodeMeter is introduced, all the computers that are currently 
running 12d Model with a Local CodeMeter will not need the CodeMeter drivers installed.

However, such CodeMeter Client computers will need a modification to their dongles.4d file to 
tell the computer that 12d Model licenses can be obtained from a 12d Network CodeMeter 
rather than just a 12d Local CodeMeter (see 9.4 dongles.4d and nodes.4d on page 69).
Also a valid nodes.4d file for the 12d dongle inside the 12d Network CodeMeter is needed 
(see 10.5 Updating Licenses in Network CodeMeters on page 112).
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9.2 Installing CodeMeter Drivers
IMPORTANT WARNING - Do not attach a 12d CodeMeter to your computer until after you have 
installed the CodeMeter drivers.

This section is installing the CodeMeter drivers.

This must be done on the computer that will have the 12d Network CodeMeter attached to it (the 
CodeMeter Server) and also for all the computers that are 12d CodeMeter Clients using the 
CodeMeter Server.

If the computer has no CodeMeter Drivers, or old CodeMeter Drivers, installed on it, go to 5.4 
Installing the CodeMeter Drivers Separately on page 35.

If a computer is to become a CodeMeter Sever but already has the CodeMeter Drivers installed 
on it, then go straight to 9.3 Setting up a 12d Network CodeMeter on page 62.

If the computer is already set up as a CodeMeter Server and you are adding a new 12d dongle 
to the 12d Network CodeMeter, or upgrading the number of 12d licenses on a 12d dongle in the 
12d Network CodeMeter, go to 10.5.1.1 Updating Using the .WibuCmRaU File on page 116.

If you are replacing the existing 12d Network CodeMeter by a new 12d Network CodeMeter, go 
to 10.6 Replacing an Existing Network CodeMeter on page 120.
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What is Done to the Computer By Step 1
1. CodeMeter Drivers
The CodeMeter drivers that allows software to access CodeMeters anywhere on the network is 
installed.

2. CodeMeter Runtime Server
The service CodeMeter Runtime Server service is also installed and started on the computer 
and if you look in the Services tab of the Windows Task Manager, the CodeMeter Runtime 
Server will be shown as Running.

If for some reason the CodeMeter Runtime Server is shown as Stopped, to restart it again go 
to Step 6. Starting the 12d Network Server on page 67.

3. CodeMeter Icon
 
As well as installing the CodeMeter drivers., a CodeMeter icon is installed on 
your task bar

Clicking on the CodeMeter icon brings up the CodeMeter Control Center which shows any 
CodeMeters that are attached to the this computer. The CodeMeter Control Center also has 
options to stop and start the CodeMeter Runtime Server and bring up the WebAdmin panel to 
examine the content of CodeMeters anywhere on the network.
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.

If the computer is to be a CodeMeter Server, then the next step is to check the Network 
CodeMeter. If this is the case then go to 9.3 Setting up a 12d Network CodeMeter on page 62.

If the computer is a CodeMeter Client, then the next steps are to
(a) set up the dongles.4d file to see the 12d Network CodeMeter (and if required a particular 

12d dongle inside the 12d Network CodeMeter) 
and

(b) set up the nodes.4d with the authorization for the required 12d dongle number.

 For setting up dongles.4d and nodes.4d, see 9.4 dongles.4d and nodes.4d on page 69.
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9.3 Setting up a 12d Network CodeMeter
The CodeMeter drivers are now installed and the CodeMeter Runtime Server is running.
The next steps are to actually attach the 12d Network CodeMeter, examine its contents to make 
sure everything that are correct, and then start up the 12d Network Server so that other 
computers in the network will be able to see and use the 12d Network CodeMeter.
These steps will complete the setting up of the 12d Network CodeMeter as a 12d CodeMeter 
Server.

Step 2.Attaching the Network CodeMeter
The physical CodeMeter number can be found on the part of the 12d Network CodeMeter that 
is pushed into the USB port (the CodeMeter shaft). The number starts with 2-.
This number needs to be recorded but you need to have very good eyes to be able to read it or 
have a magnifying glass. 

If the CodeMeter number can’t be read, it is also possible to obtain the number after the 12d 
Network CodeMeter is plugged into the USB port of the computer (see Step 3. Checking that the 
12d Network CodeMeter is Visible on page 63.)

12d Network CodeMeter - Silver USB

CodeMeter number

Now that the CodeMeter drivers are installed on the computer, the 12d Network CodeMeter can 
now be attached to the USB port on the computer.
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Step 3.Checking that the 12d Network CodeMeter is Visible
 

Click on the CodeMeter icon that was installed on your task bar 
to bring up the CodeMeter Control Center which shows what 
CodeMeters are on this computer.

CodeMeter number

The CodeMeter number, that is written on the shaft of the CodeMeter, should be displayed in the 
CodeMeter Control Center.

Step 4.What to Do If You Can’t See the CodeMeter
If you were unable to see the CodeMeter number in the CodeMeter Control Center then first 
check that the service CodeMeter Runtime Server service is installed and running on the 
computer by looking in the Windows Task Manager and checking that CodeMeter Runtime 
Server is shown as Running.

If for some reason the CodeMeter Runtime Server is there but shown as Stopped, to restart it 
again see Step 6. Starting the 12d Network Server on page 67.

 If you are still having problems then contact your 12d Model Reseller.
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Step 5.Checking the Virtual 12d Virtual Dongles Inside the Network CodeMeter
The 12d Network CodeMeter alone is not enough to provide a license to run 12d Model.
There must also be a 12d virtual dongle inside the Network CodeMeter. 
It is the 12d virtual dongle that controls how many network licenses of 12d Model are.available. 

Aside: 
The 12d virtual dongle issues the 12d Model licenses but the actual 12d Model modules 
that go with a license from a 12d virtual dongle is controlled by a matching entry in the 
nodes.4d file. This means that what 12d Model modules you have can be updated by just 
adding a new entry for the nodes.4d file. The word virtual is used because the 12d virtual 
dongle is NOT a physical lock. The 12d virtual dongle is often abbreviated to 12d dongle.

Clicking on the WebAdmin button on the CodeMeter Control Center brings up the CodeMeter 
WebAdmin panel which is used to display information about any of the CodeMeters that it can 
see. Note - you may have one of two versions of WebAdmin - see 10.8 Which Version of 
WebAdmin? on page 121.

For WebAdmin 6:
Clicking on the tab Content >Licenses of the CodeMeter WebAdmin panel displays the 
12d virtual dongle information stored in the selected CodeMeter.

12d Product name
12d Customer name

12d virtual dongle number Total number of licenses on 
the 12d virtual dongle

For instructions on how to select and see CodeMeters on a particular 12d Network Server, 
see 10.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 99

For WebAdmin 5:
Clicking on the tab Content >Licenses of the CodeMeter WebAdmin panel displays the 
12d virtual dongle information stored in the selected CodeMeter.
Page 64 Setting up a 12d Network CodeMeter



Chapter 9  Network CodeMeters
12d Product name
12d Customer name

12d virtual dongle number

Total number of licenses on 
the 12d dongle

For instructions on how to select and see CodeMeters on a particular Network Server, see 
10.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5 on page 106

If there are no 12d dongle numbers displayed inside the 12d Network CodeMeter, or no 12d 
dongle number starting with ec, contact your 12d Model Reseller.
You need to make a note of the 12d dongle number because there must be a valid entry with 
the matching 12d dongle number in the nodes.4d file.

Note: The WebAdmin button is only selectable if the CodeMeter Runtime Server is running. If 
it is Stopped, to restart it again see Step 6. Starting the 12d Network Server on page 67.

Important Note:
There may be more than one 12d dongle number inside the one physical CodeMeter 
Container. That is why they are also referred to as virtual 12d dongles. For example, 
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two 12d dongle numbers in the CodeMeter
Number of licenses on 
each 12d dongle

Within 12d Model, it is possible to address specific 12d Network CodeMeters, and specific 12d 
dongles within a 12d Network CodeMeter. This is done via the dongles.4d file and how it is set 
up is described in 9.4.1 Updating dongles.4d on page 69.
Page 66 Setting up a 12d Network CodeMeter



Chapter 9  Network CodeMeters
Step 6.Starting the 12d Network Server

For a 12d Network CodeMeter to be seen and used by other computers in the network, the 12d 
Network Server needs to be running on the computer with the 12d Network CodeMeter on it. 
The CodeMeter WebAdmin panel is used to start the 12d Network Server. 
Note: The 12d Network Server is controlled by the CodeMeter Runtime Server service so it is 
critical that the CodeMeter Runtime Server service is running.

To bring up the CodeMeter WebAdmin panel, click on the WebAdmin button on the CodeMeter 
Control Center.

For WebAdmin 6:
In the CodeMeter WebAdmin panel, click on the Configuration >Server >Server access 
menu.

Click on Enable and then Apply.
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For WebAdmin 5:
In the CodeMeter WebAdmin panel, click on the Configuration >Server tab and then tick 
on Run Network Server.

Click on Apply and a message Operation completed successfully - please wait will 
appear and when it disappears, the above panel is displayed again.
The 12d Network Server should now be running.

Note that unlike the CodeMeter Runtime Server service, the 12d Network Server is not a 
service and so will not appear in the Windows Task Manager. 

The computer with the 12d Network CodeMeter is now ready to use as a 12d CodeMeter 
Server.
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9.4 dongles.4d and nodes.4d
For 12d Model to be able to create and/or open existing projects, it requires 
(a) a license from a 12d dongle inside a 12d Network CodeMeter 
and

(b) a valid entry with the matching 12d dongle number in the nodes.4d file 

Once dongles.4d and nodes.4d have been updated, they must be the nodes.4d and 
dongles.4d files that are used for any computer wanting to use a 12d Model license from the 
12d Network CodeMeter.

For the updating of dongles.4d, see 9.4.1 Updating dongles.4d on page 69.

For the updating of nodes.4d, see 9.4.2 Updating nodes.4d on page 77.

9.4.1 Updating dongles.4d
The dongles.4d file lists the computers to search for 12d Network CodeMeters, 12d Local 
CodeMeters and Wibu dongles to find 12d dongle numbers. 
It also defines the order to search for CodeMeters and Wibus.

When 12d Model is installed on a computer, it installs a dongles.4d file that is configured to only 
look for Local (standalone) CodeMeters and Local Wibus.
For each computer that needs to access to a 12d Network CodeMeter, a modification has to be 
made to the dongles.4d file used by that computer to tell 12d Model to search for a 12d 
Network CodeMeter and not just use a 12d Local CodeMeter.
The updated dongles.4d is then placed in the standard search path for a set up file for that 
computer and the particular version of 12d Model. For example, for 12d Model 15, the 
dongles.4d could be in c:\12d\15.00\User. Or it uses a file pointed to by the environment 
variable DONGLES_4D in env.4d. This means that the dongles.4d file could be on the one 
central computer and accessed by all the other computers.

Important Note
In the initial 12d Model installation, the dongles.4d file is a set up file and is installed in the 
Set_ups folder under the 12d Model version number.
For example, for 12d Model 15

Program files\12d\12dmodel\15.00\Set_ups
All the files in Set_ups are supplied by 12d Solutions and must not be modified. Hence in 
updating the default dongles.4d file, the procedures outlined will modify a copy of the 
dongles.4d file.
The editing of dongles.4d does not have to be on the computer that the 12d Network 
CodeMeter is on. It can be done from any computer.

To edit the donges.4d file you need to start up 12d Model BUT you don’t have to open a 
12d Model project. The current dongles.4d file can be edited by simply starting up 12d Model 
and clicking on the dongles.4d button on the front panel.
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Or if the 12d Model you are running is already authorized and you are in an open project, by 
picking the option
    Projects =>Management =>Dongles =>Dongles.4d editor

Both of these bring up the Dongles.4d Editor panel.

Add a new entry

List of CodeMeter 
and Wibu dongles to 
search for.
They are searched 
for in the order in this 
list.

If the dongles.4d is the one installed with 12d Model then it will only be looking for Local 
(standalone) CodeMeters and Local (standalone) Wibus:

What it needs in the list is an entry to tell 12d Model to look for your 12d Network CodeMeter.
To Add a new entry to dongles.4d, click on the Add button which then bring up the 
Add a New Dongle panel. 
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.

To add an entry to search for all Network CodeMeter on the network, see 9.4.1.1 Search for any 
12d Network CodeMeter on page 71.

To add an entry to use a particular 12d dongle number in a particular 12d Network CodeMeter, 
see 9.4.1.2 Using a 12d Dongle Number in a 12d Network CodeMeter on page 74.

9.4.1.1 Search for any 12d Network CodeMeter
The simplest entry to add is the one that searches for all 12d Network CodeMeters on the 
network.
.

For this case, select CodeMeter - auto network for Type and then click on Add.
A new entry with the default name New dongle is added to the bottom of the list.
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Click in the Name field and change New dongle to whatever you want, say CodeMeter - auto 
network.
The order in the list is the order that 12d Model searches to find a valid dongle.
For example if you want to always search for a local dongle BEFORE the 12d Network 
CodeMeter then leave the order as it is.

This is what is normally wanted. That is, use a local dongle if it exists, otherwise use a network 
license.

If you want to always search for a 12d Network CodeMeter BEFORE a local dongle then use 
the Up arrow icon to move the CodeMeter - auto network to the top of the list. This is rarely 
wanted.
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To save the information to the dongles.4d file, press Write to bring up the 
Write Setup FIle "dongles.4d" panel.

 

Tick on User folder and then on Write.

For any computer wanting to use a 12d Model license from a 12d Network CodeMeter, the 
updated dongles.4d must be placed in the standard search path for the User folder, or in the 
folder pointed to by the environment variable USER_4D in env.4d, or is the file pointed to by the 
environment variable DONGLES_4D in env.4d.
Using DONGLES_4D means that the dongles.4d file could be on a central computer that can 
be accessed by all the other Client computers.

Note:
 If you don’t want to search for a Local dongle at all. simply highlight the Local entries and click 
on the delete icon to delete them.

WARNING
Projects can have a local dongles.4d file and when the project is selected, the local dongles.4d is 
used before any other dongles.4d. If the local file does not have the correct network information 
in it then the authorization will fail because 12d Model is no longer being instructed to use the 
Network CodeMeter.
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9.4.1.2 Using a 12d Dongle Number in a 12d Network CodeMeter
To point to a particular 12d dongle number, it helps to know the physical CodeMeter number 
that the 12d dongle number is in. 

If you don’t already know this, the CodeMeter WebAdmin panel can be used to look inside the 
Network CodeMeter. See Step 5. Checking the Virtual 12d Virtual Dongles Inside the Network 
CodeMeter on page 64.
Note: if you still don’t know what Network CodeMeter the 12d dongle is in, it is possible to find it 
when using the Dongles.4d Editor but you will need to look through the list of physical 
CodeMeter numbers and see which one contains the required 12d dongle number.

In the Add a New Dongle panel, for the case of using a particular 12d dongle number, select 
CodeMeter - network for Type and then click on Add.
.

A new entry with the default name New dongle is added to the bottom of the list.
 

CodeMeter icon

Click in the Name field and change New dongle to whatever you want but it helps to have the 
12d dongle number in the name. For example CodeMeter - ec51470022 
Next click on the CodeMeter icon at the end of the Server name field.
This will bring up the CodeMeter Browse panel that searches for all the 12d Network CodeMeters 
on the network and for all the 12d dongle numbers in them, and presents the results in a tree.
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physical CodeMeter number

12d dongle number

Fred.12d.com

Larry.12d.com

Scroll down the tree until you find the 12d dongle number you are after and click on it.
This will then write what is called the CMUNC to the Server name field.
Aside:
CMUNC is the 12d CodeMeter Universal Naming Convention. An example would be 
 //server_name.12d.com/2-2310242/1/16 
where server_name is the server name (Fred) with .12d.com added to it, followed by CodeMeter 
serial number (2-2310242), then the product code (1), and the final part being the instance within 
that product code that contains the 12d dongle number. 

Note: The instance can only be found by using the CodeMeter Browse panel.

To save the information to the dongles.4d file, press Write to bring up the 
Write Setup FIle "dongles.4d" panel.
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Tick on User folder and then on Write.

For any computer wanting to use a 12d Model license from a 12d Network CodeMeter, the 
updated dongles.4d must be placed in the standard search path for the User folder, or in the 
folder pointed to by the environment variable USER_4D in env.4d, or is the file pointed to by the 
environment variable DONGLES_4D in env.4d.
Using DONGLES_4D means that the dongles.4d file could be on a central computer that can 
be accessed by all the other Client computers.

WARNING
Projects can have a local dongles.4d file and when the project is selected, the local dongles.4d is 
used before any other dongles.4d. If the local file does not have the correct network information 
in it then the authorization will fail because 12d Model is no longer being instructed to use the 
12d Network CodeMeter.

For the updating of nodes.4d, see 9.4.1 Updating dongles.4d on page 69.
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9.4.2 Updating nodes.4d
12d Model will not create new projects or open an existing project without an authorization file 
called nodes.4d with valid information in it.
The information inside nodes.4d controls
(a) which 12d dongles are authorized to run 12d Model
(b) what version of 12d Model will run for a 12d dongle
(c) what modules are authorized for a particular 12d dongle

To authorize 12d Model to run with your 12d dongles, a file called nodes.12dxxn where xx is 
the 12d Model version number, will have been emailed to you by your local 12d Model Reseller.

For example, for 12d Model 15 the file will be called nodes.12d15n

- ec7239002

- ec7239002

Installing 12d Model on a computer sets up a Windows file association so that a nodes.12dxxn 
file is recognised brings up the Install a 12d Model xx Nodes File panel which is used is to install 
a nodes.4d file in the correct location.
In the email, double click on the files nodes.12dxxn and the Opening Mail Attachment panel 
comes up.
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- ec7239002

- ec7239002

Open
click on

Click on Open and then the Install a 12d Model xx Nodes File panel appears.

The choices for Operation are:
    Prepend - if a nodes.4d file already exists, the information in the nodes.12dxxn file is added 

to the beginning of the existing nodes file. A backup up copy of the existing nodes.4d is 
created THIS IS THE NORMAL CHOICE.

    Replace - if a nodes.4d file already exists, it is replaced by a new nodes.4d file with the 
information in the nodes.12dxxn file in it. A backup up copy of the existing nodes.4d is 
created.

    Append - if a nodes.4d file already exists, the information in the nodes.12dxxn file is added 
to the end of the existing nodes file. A backup up copy of the existing nodes.4d is created. 
THIS IS RARE.

Select Prepend, Replace or Append and then click Install.

The new/updated nodes.4d file is created in the Destination folder (default is C:\12d\xx.00) and 
if a nodes.4d file already existed, a backup copy of it is made.
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Note - if you don’t have the file nodes.12dxxn attached to an email but instead have the file in a 
folder accessible from your computer, then you can do the following:
If there is a nodes.12dxxn file, double click on that file and the Install a 12d Model Nodes File panel 
should appear and you continue with the instructions above.

If that doesn’t work, start up 12d Model xx and click on the Nodes.4d button at the bottom of the 
Open a Recent Project panel. This will also bring up the Install a 12d Model Nodes File panel and you 
can browse for the nodes.12dxxn file in the Source panel field. You can then continue with the 
instructions above.

For any computer wanting to use a 12d Model license from a 12d Network CodeMeter, the 
updated nodes.4d is then placed in the standard search path for the User folder.
For example, for 12d Model 15 a nodes.4d in c:\12d\15.00, or a file pointed to by the 
environment variable AUTHORIZATION_4D in env.4d.

Using AUTHORIZATION_4D means that the nodes.4d file can be on a central computer and 
accessed by all the other Client computers.

Now that the dongles.4d file and the nodes.4d file have been updated, any computer on the 
network that has the CodeMeter drivers installed and has the updated dongles.4d and nodes.4d 
file should be able to obtain a 12d Model license from a Network CodeMeter. That is, it becomes 
a 12d CodeMeter Client.

This ends the notes for setting up the 12d CodeMeter Server and any 12d CodeMeter Clients.
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10  CodeMeter Control Center & WebAdmin
The CodeMeter Control Center is used on a particular computer to display which CodeMeters 
are on the computer the Control Centre is being run on, to stop and start the CodeMeter 
Runtime Server service on the computer, Certify CodeMeters on the computer and to update 
the contents of any CodeMeters on the computer. It can also bring up the CodeMeter 
WebAdmin panel.

2-2310242

The CodeMeter WebAdmin can do whatever the Control Centre can do but it can work on 
CodeMeters on ANY computer that are visible on the network and it has permission to access.
 

Options under the Process menu can start and stop the CodeMeter Runtime Server service on 
the computer. See 10.1 Stopping & Starting the CodeMeter Runtime Server on page 81)

The License Update button is for reporting on, and updating the information about 12d Model 
licenses for any CodeMeter (Network or Standalone) attached to this computer. See 10.5 
Updating Licenses in Network CodeMeters on page 112).

The WebAdmin button brings up the CodeMeter WebAdmin panel which can display information 
about 12d Model licenses for any CodeMeter (Network or Standalone) that is visible on the 
computer network. See 10.8 Which Version of WebAdmin? on page 121.

To bring up the CodeMeter Control Center, click on the 
CodeMeter icon that was installed on your task bar.
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10.1 Stopping & Starting the CodeMeter Runtime Server
Some changes to CodeMeter configurations on a computer require that the CodeMeter 
Runtime Server service is restarted on the computer. In these cases, there is usually a message 
to say Changes only take effect after restarting CodeMeter.
The stopping and starting of the CodeMeter Runtime Server on a particular computer can be 
done from running CodeMeter Control Center on that computer, or WebAdmin can be used to 
stop and start the CodeMeter Runtime Server on any computer that is has access to and 
adequate permissions.

See

 10.1.1 CodeMeter Runtime Server - Control Centre on page 82
 10.1.2 CodeMeter Runtime Server - WebAdmin on page 85
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10.1.1 CodeMeter Runtime Server - Control Centre
 

Click on the CodeMeter icon that was installed on your task bar 
to bring up the CodeMeter Control Center.

Clicking on the WebAdmin button on the CodeMeter Control Center brings up the CodeMeter 
WebAdmin.

For WebAdmin 6:
To stop the CodeMeter Runtime Server service, click on Process >Stop CodeMeter Service 
in the CodeMeter Control Center.

You will be asked to confirm that this is to be done.

The CodeMeter Control Center will then reappear with no CodeMeters being found on the 
computer and if you look in the Windows Task Manager, the CodeMeter Runtime Server 
service will be shown as Stopped.

To start the CodeMeter Runtime Server service, click on Process >Start CodeMeter Service 
in the CodeMeter Control Center.
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You will be again be asked to confirm that it is to be done.
After a short time, the CodeMeter Control Center panel will then reappear displaying the 
CodeMeters on this computer.

CodeMeter number

If you look in the Windows Task Manager, the CodeMeter Runtime Server service will be shown 
as Running.
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Note: There may be more than one CodeMeter attached to the computer. For example

CodeMeter numbers

Warning: Access to all the CodeMeters on the computer is stopped by stopping the CodeMeter 
Runtime Server service.
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10.1.2 CodeMeter Runtime Server - WebAdmin
To bring up the CodeMeter WebAdmin panel, click on the WebAdmin button on the CodeMeter 
Control Center.

For WebAdmin 6:
For instructions on how to select and see CodeMeters on a particular Network Server, see 
10.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 99

Once the required Computer is selected in the CodeMeter WebAdmin panel, to stop the 
Network Server, click on the Configuration >Server >Server access menu, then select 
Disable and finally click on Apply.,

The CodeMeter Control Center will then reappear with no CodeMeters being found on the 
computer and if you look in the Windows Task Manager, the CodeMeter Runtime Server 
service will be shown as Stopped.

To start the CodeMeter Runtime Server service, click on the Configuration 
>Server >Server access menu, then select Enable and finally click on Apply
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You will be again be asked to confirm that it is to be done.

If you look in the Windows Task Manager, the CodeMeter Runtime Server service will be shown 
as Running.

Warning: Access to all the CodeMeters on the computer is stopped by stopping the CodeMeter 
Runtime Server Service.
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10.2 Port Address for CodeMeter Communication
For CodeMeter WebAdmin 6, see 10.2.1 Port Address - WebAdmin 6 on page 87
For CodeMeter WebAdmin 5, see 10.2.2 Port Address - WebAdmin 5 on page 88.

10.2.1 Port Address - WebAdmin 6
The CodeMeter License Server uses a specific IP port (defaulted on 22350) to communicate 
with your computer and the network. This network port is registered at IANA (Internet Assigned 
Numbers Authority) and is uniquely assigned for CodeMeter® communication. 

Please make sure that your firewall is not blocking this port.
Enable the used IP port 22350 and make sure it is accessible by CodeMeter®, i.e. share the 
communication for this IP port.

The IP port used for communication can be changed by the CodeMeter WebAdmin panel.
Click on the Configuration >Server >Server access menu.

Change the Network Port: field to the number of the port that you want the CodeMeter to 
communicate over, and then press Apply.
Important: For the change to take affect, you need to stop and then restart the CodeMeter 
Runtime Server service. See 10.1 Stopping & Starting the CodeMeter Runtime Server on 
page 81.
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10.2.2 Port Address - WebAdmin 5
The CodeMeter License Server uses a specific IP port (defaulted on 22350) to communicate 
with your computer and the network. This network port is registered at IANA (Internet Assigned 
Numbers Authority) and is uniquely assigned for CodeMeter® communication. 

Please make sure that your firewall is not blocking this port.
Enable the used IP port 22350 and make sure it is accessible by CodeMeter®, i.e. share the 
communication for this IP port.

The IP port used for communication can be changed by the CodeMeter WebAdmin panel.
Click on the Configuration >Server tab.

Change the Network Port: field to the number of the port that you want the CodeMeter to 
communicate over, and then press Apply.
Important: For the change to take affect, you need to stop and then restart the CodeMeter 
Runtime Server service. See 10.1 Stopping & Starting the CodeMeter Runtime Server on 
page 81.
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10.3 Certifying CodeMeters
Updating the Certified Time in a CodeMeter must be done at least every two month over the 
Internet and Certifying needs communication between the CodeMeter and a Certified Wibu 
Time Server.
So for Certification to occur, a computer that can access the CodeMeter must also have access 
to the Internet at least every two months so it can run the Certification.

Certifying a CodeMeter can be done
(a) manually from inside 12d Model itself

See 5.1 Certifying CodeMeters from 12d Model on page 30
(b) automatically by 12d Model 

See 5.2 Automatically Certifying CodeMeters from 12d Model on page 32
(c) outside of 12d Model when the CodeMeter is on the computer you are using outside

Using the CodeMeter Control Centre - see 5.3 Certifying CodeMeters Using Control 
Center on page 33.

or

(d) outside 12d Model when the CodeMeter is NOT on the computer your are using
It is possible to certify CodeMeters that are on other computers but this is usually only 
needed by Administrators. See 10.3.1 Certifying CodeMeters Using WebAdmin on page 90

Important Note
To display and update the Certified Time in the CodeMeter, you need access over the Internet 
to a CodeMeter Time Server (see 10.3.2 Time Servers for Certified Time on page 96) and this 
Internet communication must be allowed to be done through an IP port (see 9 Network 
CodeMeters on page 55).

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.
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10.3.1 Certifying CodeMeters Using WebAdmin
If the CodeMeter is NOT attached to your current computer you need to use the 
CodeMeter WebAdmin panel which is brought up by clicking on the WebAdmin button on the 
CodeMeter Control Center.

For CodeMeter WebAdmin 6, see 10.3.1.1 Certifying CodeMeters Using WebAdmin 6 on 
page 91
For CodeMeter WebAdmin 5, see 10.3.1.2 Certifying CodeMeters Using WebAdmin 5 on 
page 95.
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10.3.1.1 Certifying CodeMeters Using WebAdmin 6
After getting up CodeMeter WebAdmin panel up, on the Dashboard you need to set the Current 
Server to the server that the CodeMeter is on.

To get a list of servers, click on the Current Server: field at the bottom of the Dashboard and you 
will get a list of the servers found.
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If there is more than one CodeMeter on that computer/server, select the one that you want to 
examine and click on Apply.

The information about the selected Server will be displayed, including any CodeMeters that are 
found on the server and the current sessions on them.

If there is more than one CodeMeter (CmContainer) on that computer/server, select the one 
that you want by Walking right on the Container menu.
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Information about the selected CodeMeter is then displayed.

Click on the CmContainer Info button to expand the information displayed. 

The current Certified time for that CodeMeter will be displayed.
Page 93Certifying CodeMeters



12d Model
The Certified time for that CodeMeter can be updated to the current date by clicking on the 
Update button.
. 

If you have permission to do so, the Certified time for that CodeMeter can be updated to the 
current date by clicking on the Update button.

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.

Important Note
To display and update the Certified Time in the CodeMeter, you need access over the Internet 
to a CodeMeter Time Server (see 10.3.2 Time Servers for Certified Time on page 96). This 
Internet communication is through a set IP port (see 9 Network CodeMeters on page 55).

click to update the 
Certified time
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10.3.1.2 Certifying CodeMeters Using WebAdmin 5

Certified time click to update the 
Certified time

After getting up CodeMeter WebAdmin panel up, on the Home tab set the Host Name: field to the 
name of the computer or server that the CodeMeter to be certified is on, and then go to the 
Content >CmContainer tab.

If there is more than one CodeMeter (CmContainer) on that computer/server, select the one 
that you want to examine in the CmContainer: field.

The Certified time for that CodeMeter can be updated to the current date by clicking on the 
Update button.

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.

Important Note
To display and update the Certified Time in the CodeMeter, you need access over the Internet 
to a CodeMeter Time Server (see 10.3.2 Time Servers for Certified Time on page 96). This 
Internet communication is through a set IP port (see 9 Network CodeMeters on page 55).
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10.3.2 Time Servers for Certified Time
When you certify a CodeMeter it searches the internet for a CodeMeter Time Server to update 
the Certified Time in the CodeMeter.

For CodeMeter WebAdmin 6, see 10.3.2.1 Time Servers - WebAdmin 6 on page 96
For CodeMeter WebAdmin 5, see 10.3.2.2 Time Servers - WebAdmin 5 on page 97.

10.3.2.1 Time Servers - WebAdmin 6
For a particular CodeMeter on a Server, the Internet or IP addresses of the CodeMeter Time 
Servers that are searched to set the Certified Time are given in the Configuration >Certified 
Time tab of the CodeMeter WebAdmin panel.

The list of Time Servers used for this CodeMeter are then displayed.

The Time Servers list is searched in order from the top to the bottom.
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Servers in the list are added or removed using the add or remove buttons, and a highlighted entry 
in the list is moved up or down with the up and down buttons.
Clicking Apply saves these entries in the Windows Registry of the Server that the CodeMeter is 
on.

10.3.2.2 Time Servers - WebAdmin 5
For a particular CodeMeter on a Server, the Internet or IP addresses of the CodeMeter Time 
Servers that are searched to set the Certified Time are given in the Configuration >Certified Time 
tab of the CodeMeter WebAdmin panel.

The Time Servers to search are given in the list labelled Time Server: and the list is searched in 
order from the top to the bottom.
The Timer Servers can be specified by either an Internet address or an IP address.

Servers in the list are added or removed using the add or remove buttons, and a highlighted entry 
in the list is moved up or down with the up and down buttons.
Clicking Apply saves these entries in the Windows Registry of the Server that the CodeMeter is 
on.
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10.4 Monitoring and Cancelling Licenses
Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display 
information about 12d Model licenses for any CodeMeter (Network or Standalone) that is visible 
on the computer network.

For instructions on finding information about CodeMeters on a particular Network Server, see

 10.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 99
 10.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5 on page 106.
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10.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6
Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display 
information about 12d Model licenses for any CodeMeter (Network or Standalone) that is visible 
on the computer network.

The panel comes up with the Dashboard tab displaying information about one of the 
CodeMeters on this computer.

To get information about CodeMeters on another Server, you need to set the Current Server to 
the server that you wish to exam CodeMeters on.

To get a list of servers, click on the Current Server: field at the bottom of the Dashboard:
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If there is more than one CodeMeter on 
that computer/server, select the one that 
you want to examine and click on Apply.

Important Note:
It is possible to have different versions of WebAdmin installed on different Servers.
So depending on which Server you are looking at, you may now need to swap between the 
notes for WebAdmin 6 and WebAdmin 5.

For instructions on Monitoring and Cancelling Licenses on this Server, see
 10.4.2 Monitoring and Cancelling Licenses - WebAdmin 6 on page 101
 10.4.4 Monitoring and Cancelling Licenses - WebAdmin 5 on page 108.
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10.4.2 Monitoring and Cancelling Licenses - WebAdmin 6
The information about a selected Server will be displayed, including any CodeMeters that are 
found on the server and the current sessions on them.

To find out information about all the CodeMeters (CmContainer) on that computer/server, select 
the Container >All Containers option, and expand the 12d Model product code 101956 for 
each CodeMeter to show any virtual 12d dongles in a CodeMeter or any standalone 
CodeMeters.
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The example below shows a Server with three CodeMeters attached to it: one with a single 
virtual 12d dongle, one with two virtual 12d dongles and one which is a standalone CodeMeter. 

CodeMeter numbers

two virtual 12d dongles in the one CodeMeter

12d Model product code

one 12d Model virtual dongle in a CodeMeter

one standalone 12d Model CodeMeter
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If there is more than one CodeMeter (CmContainer) on the computer/server, information about 
just one of them can be obtained by walking right on the Container >All Container menu and 
selecting the required CodeMeter number.

Information about the selected CodeMeter is then displayed. Expanding the 12d Model product 
code 101956 will show any virtual 12d dongles in a CodeMeter.

And as discussed in the Certifying section, clicking on the CmContainer Info button expands the 
information displayed for the CodeMeter.
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To see information about the total number of licenses available for each virtual 12d dongle, and 
the number of licenses currently being used and how many are left to use, click on the 
License Monitoring >All Licenses menu.

Information about the selected CodeMeter is then displayed.
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one 12d Model virtual dongle in a CodeMeter

Number of licenses on 
each virtual 12d dongle

two 12d Model virtual dongles in a CodeMeter

Number of licenses free 

Number of licenses being used 

Clicking on the Product Code 1 for a CodeMeter showing some licenses are being used will (for 
example ec514470113), displays the user name of the user of each license (session).

If you have the required permission, the session can be terminated by selecting Cancel at the 
end of the session row and in the Action column.

click to Cancel the session
user for the session
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10.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5
Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display 
information about 12d Model licenses for any CodeMeter (Network or Standalone) that is visible 
on the computer network.

The panel comes up with the Content >CmContainer tab displaying information about one of 
the CodeMeters on this computer.

CodeMeters on other computer can be examined by clicking on the Home tab and then clicking 
on the displayed Host Name: to bring up the panel to select a Server to check for CodeMeters.

A pop up list is automatically created of all the computers that are visible on the network and 
have CodeMeters on them.
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Picking a Server/Computer from the list and then pressing Select will set the Host Name: to the 
selected computer and all the tabs on the CodeMeter WebAdmin panel will then show information 
about the CodeMeters on the selected computer.

Important Note:
It is possible to have different versions of WebAdmin installed on different Servers.
So depending on which Server you are looking at, you may now need to swap between the 
notes for WebAdmin 6 and WebAdmin 5.

For instructions on Monitoring and Cancelling Licenses on this Server, see
 10.4.2 Monitoring and Cancelling Licenses - WebAdmin 6 on page 101
 10.4.4 Monitoring and Cancelling Licenses - WebAdmin 5 on page 108.
Page 107Monitoring and Cancelling Licenses



12d Model
10.4.4 Monitoring and Cancelling Licenses - WebAdmin 5
The tab Content >Licenses will display information about any selected CodeMeter on the 
selected computer.
 

To see how many 12d Model licenses are being used by each virtual 12d dongle in all the 
CodeMeters on a particular Server, when that server has been selected on the Home tab, click 
on the Server >User tab.
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one 12d Model virtual dongle in a CodeMeter

Number of licenses on 
each virtual 12d dongle

two 12d Model virtual dongles in a CodeMeter

Number of licenses free 

The 12d dongles are displayed under the section titled 101956 | 12d.com.
The table also displays how many 12d Model licenses are on each 12d dongles, and how 
many of those licenses are still Free to be used.

Details about each user on a particular 12d dongle is displayed by clicking on the Details button 
at the end of the row for that virtual 12d dongle.
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A particular user session of 12d Model can be stopped by clicking on the Cancel button.
A Confirmation panel will then be brought up.

 

If you click on OK and have permission to be able to stop people, the session will be terminated.
If you do not have permission, you will get the message
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10.5 Updating Licenses in Network CodeMeters
A Network CodeMeter can contain one or more virtual 12d dongles and each of these virtual 
dongles can have a different number of 12d Model licenses.
Adding extra 12d dongles, or modifying the number of licenses on each of the 12d dongles can 
be done electronically without having to remove the Network CodeMeter from the computer.
Updating virtual 12d dongles is usually one simple step but it may involve two steps.

Step 1.Generating the CodeMeter Context File (.WibuCmRaC) - only if asked for
The context (.WibuCmRaC) file holds information about the current settings in the Network 
CodeMeter. 12d Solutions usually knows these setting for your Network CodeMeter and 
this step is normally not required. 
However sometimes you may be asked to generate the .WibuCmRaC file and email it to 
your local 12d Model Distributor.

If you need to generate the .WibuCmRaC file, go to 10.5.1 Generating the Context File 
(.WibuCmRac) on page 113.

Step 2.Updating the Network CodeMeter with the .WibuCmRaU file
You will be emailed one or more special files (ending in .WibuCmRaU) which are used to 
update the information about the virtual 12d dongles in the Network CodeMeter.
If you have a WibuCmRaU file, go to 10.5.1.1 Updating Using the .WibuCmRaU File on 
page 116.
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10.5.1 Generating the Context File (.WibuCmRac)

2-2310242

Click on License 
Update

The follow steps will generate a new context file for a Network CodeMeter using the CodeMeter 
Control Center panel.
 

Click on License Update to bring up the CmFAS Assistant panel.

Select Next.

The CodeMeter Control Center panel is accessed by clicking on 
the CodeMeter icon that was installed on your task bar.
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Click on Create receipt

 

Tick on Create receipt and then select Next.

Tick on 12d.com and then select Next.

Tick on 12d.com
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Select the file to use to update the CodeMeter and then select Commit.
Email the .WibuCmRaC file to your 12d Model Reseller.
Your 12d Model Reseller will then be able to send you a .WibuCmRaU file to update your 
Network CodeMeter.
For information on how to use a .WibuCmRaU f file to update the CodeMeter, see 10.5.1.1 
Updating Using the .WibuCmRaU File on page 116.

Select the folder where the file is to be written to.
Leave the actual file name as it is.

Click on Commit
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10.5.1.1 Updating Using the .WibuCmRaU File
The number of virtual 12d dongles and the number of 12d Model licenses on them can be 
changed electronically without having to remove the CodeMeter from the computer.

To update the CodeMeter, you will be sent a file starting with the CodeMeter number, then the 
date and finally ending in .WibuCmRau.
The steps below will show how to use the .WibuCmRau file to update the Network CodeMeter

You need to have System Administrator rights to update the Network CodeMeter.

Before updating a Network CodeMeter dongle, run the CodeMeter WebAdmin software to 
check that no one is using the Network CodeMeter (10.4 Monitoring and Cancelling Licenses on 
page 98). The CodeMeter WebAdmin displays network dongle activity and it can also remove 
users from the network dongle.
Once all the users are off the Network CodeMeter, double click on the file 
codemeter_number_date.WibuCmRau and the following panel will appear: 

Select Yes and a panel to say how many CodeMeters have been updated should appear.

Click on OK

The CodeMeter should now be updated. The CodeMeter WebAdmin can be used to check that 
the new number of licenses, or new number of 12d dongles, are now available.

WARNING: If there is no association for the .WibuCmRau file, double clicking on 
the .WibuCmRau file won’t work. In that case go to 10.5.1.2 Manually Updating the Network 
CodeMeter on page 117.

Nodes.4d:
If you’ve added a new virtual 12d dongle to your CodeMeter then a new nodes.4d file with that 
12d dongle number in it will be needed. If all you did was change the number of licenses for an 
existing 12d dongle in the Network CodeMeter then a new nodes.4d file is not required.
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10.5.1.2 Manually Updating the Network CodeMeter
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Click on License 

If there is no association with the .WibuCmRau file then double clicking on the .WibuCmRau 
file won’t automatically run the CodeMeter update program. So instead, the update will have to 
be done manually using the CodeMeter Control Center panel.
 

Click on License Update to bring up the CmFAS Assistant panel.

Select Next.

The CodeMeter Control Center panel is accessed by clicking on 
the CodeMeter icon that was installed on your task bar.
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Click on Import license update

 

Tick on Import license update and then Next.

Select the file to use to update the CodeMeter and then select on Commit.

Nodes.4d:
If you’ve added a new virtual 12d dongle to your CodeMeter then a new nodes.4d file with that 
12d dongle number in it will be needed. If all you did was change the number of licenses for an 
existing 12d dongle in the Network CodeMeter then a new nodes.4d file is not required.

Note - if the CodeMeter that the file applies to is not on the computer then an Error message will 
be brought up. See 10.5.2 Errors Updating the Network CodeMeter on page 119.

Select the file to use to update the CodeMeter

Click on Commit
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10.5.2 Errors Updating the Network CodeMeter
If there was a problem, instead of the dialogue stating that the CodeMeter has been updated, a 
CodeMeter error panel will appear. For example:

If you can’t work out what your error was, email the error message to your 12d Model Reseller.
Doing a Print Screen and saving the png or bmp is the best way to record details of the error and 
send the image to your 12d Model Reseller.
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10.6 Replacing an Existing Network CodeMeter
Before removing a Network CodeMeter, run the CodeMeter WebAdmin software to check that no 
one is using the Network CodeMeter dongle (10.4 Monitoring and Cancelling Licenses on 
page 98).
If there are no user on the Network CodeMeter, the existing Network CodeMeter can be removed 
from the computer and the new Network CodeMeter attached.
The new Network CodeMeter should now be ready to use. 

 

NOTE - a new nodes file will be required for the new virtual 12d dongles that are in the new 
Network CodeMeter.

10.7 End of the Notes on Network CodeMeters
This ends the general notes on the Network CodeMeter.
However information on Certifying Network CodeMeters is covered in 8 Errors Installing and 
Authorising on page 51.

If you need to install 12d Model on a computer, go to the section 2 Installing 12d Model 15 
Release Version on page 6.

The links for downloading documentation on 12d Model are given in 6 Documentation on 
page 40.
The links for downloading information, power points and videos on what is new in 12d Model 15 
are given in 7 What’s New in 12d Model 15 on page 49.
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10.8 Which Version of WebAdmin?
Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display 
information about 12d Model licenses for any CodeMeter (Network or Standalone) that is visible 
on Servers in the computer network.

Depending on when the CodeMeter was installed on a particular Server, you can get different 
versions of the WebAdmin pages.

If on a Server the WebAdmin Dashboard page looks like:

In this case you need to follow 
instructions and images for 
CodeMeter WebAdmin 6

Otherwise if the WebAdmin Home page on a Server looks like:

In this case you need to follow 
instructions and images for 
CodeMeter WebAdmin 5

Important Note:
It is possible to have different versions of WebAdmin installed on different Servers.
So depending on which Server you are looking at, you may need to swap between the notes 
for WebAdmin 6 and WebAdmin 5.

For instructions on finding information about CodeMeters on a particular Network Server, see

 10.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 99
 10.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5 on page 106.
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